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MAKE YOUR BEST SHOT...
by Marie Rakoczy

It’s a new year, so if you are still in search of a resolution, 
how about directing some of your thoughts towards organiz-
ing your images?  

The more photos you take, the more storage space you 
need, and the more quickly disorganization can set in.  Pho-
toshop Elements does offer the Organizer as a tool for put-
ting some order to your work.  This tool allows you to keep 
track of your photos by date, and also allows you to sort 
them into “collections” and give them tags, categories, and 
subcategories.  This is a great tool for someone who has 
a lot of time on their hands, and if your photos are already 
fairly well organized, maybe this is a step that you can take 
to make them even more organized (you can do it when you 
are done storing your canned goods in alphabetical order!).  
But for most of us, just keeping some simple order (any order) 
is probably an improvement over our current system.

One suggestion is to create a file system on your computer 
that is date-based.  The Organizer does this for you, but you 
might find it easier to do on your own, especially if you have 
a separate laptop computer that you use for vacation photo 
shoots.  Organizing independently of Photoshop Elements 
will give you a database that you can easily access both 
inside and outside Elements.  With this method, you can 
organize as you go along, then merge the new files with the 
other archived ones when you get home.  

Every vacation day, when I upload my photos to the vaca-
tion laptop using the Adobe Photo utility, they come across as 
dated files.  I place them in a directory for that vacation (e.g. 
“Northwoods Fall Trip”) and within each day’s folder, I create 
separate folders by subject and move the photos into the 
appropriate subject folders.  It’s good to do this on vacation 
because the subjects are still clear in your mind and you are 
usually anxious to look at your shots anyway.  If you do not 
take a laptop on vacation, you should take notes of your photo 
subjects by day to make it easier to sort them out when you 
arrive home.  A glance at the directory would show this:

	 My Pictures
	       Northwoods Fall Trip
		  Sept 28 2008
			   Brockway Mountain
			   Cliff Drive
			   Eagle River
			   Lighthouses

Resolve To Get Organized – Storing, and Backing Up Your Images
		  Sept 29 2008
			   Logging Roads
			   Ore Boats
			   Color on Route 41
			   Lake Medora     (etc.)
After vacation, I burn DVD’s of my work, which I then use 

to load the image data onto an external terabyte drive.  While 
a “terabyte” may sound like a dinosaur of some kind, it is 
actually a measure of data equivalent to 1,000 gigabytes 
(G), a gigabyte being 1,000 megabytes (M), and a megabyte 
being 1,000 kilobytes (K).  This means that if your average 
digital image is 20 M, you can fit 50,000 images on a terabyte 
drive.  (You can buy a terabyte drive for about $150). I copy 
the images right into the directory (by date) where they be-
long, and I organize by quarter.  If you replace “Northwoods 
Fall Trip” in the example above with July-Sept 2008, that is 
how the directory on the terabyte drive would look (though 
it would, of course, show plenty of other dates from July to 
September under the July-Sept 2008 folder, each containing 
many subject sub-folders).

The terabyte drive is like a “negative drawer” from 20th 
century photography.  You would never alter your negatives.  
They could be used over and over again to create new prints 
and then placed safely back into the drawer.  The terabyte 
drive is a great backup/archive and I never store any altered 
images on it, except for those in my camera club archive.

Some people like to burn a DVD or CD of their work every 
time they upload a memory card from their camera, so that 
each DVD is like another roll of film (again borrowing from 
20th Century photography).  This would also work, (and would 
also serve as a backup) though the individual DVD’s and CD’s 
would have a lot of wasted space on them since the number 
of photos on a card can vary quite a lot from day to day.

UH-OH!  I used that word -- BACKUP -- in the previ-
ous paragraph.   The word BACKUP scares a lot of people 
because they know that they heard somewhere that you’re 
supposed to have one, but they either a) don’t know how 
you create one and what you do with it, b) know what it is 
but haven’t “needed” it yet, c) know what it is and how to 
create it but are too busy to do so.  A backup is an identical 
copy of the original data, and it is your safeguard.  I’ll bet 
you knew that.  But I’ll bet that you don’t have one, or if you 
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do, there’s a good chance that it is not 
a safe backup.

When I first started using a digital 
camera, I did not keep a backup.  Heck, 
what could happen to my pictures?  I 
knew what I was doing, my equipment 
was good, and that stuff only happens to 
other people.  One day, I was “cleaning 
up” what I thought were some duplicate 
files and pressed DELETE to the My 
Pictures file.  The computer very nicely 
came back and told me that the file was 
too big for the recycle bin, and did I still 
want to delete?  With my all-too-quick 
finger, I clicked YES.  OOPS!!!  I wiped 
out my photos.  After a tearful encounter 
with a local computer geek who offered 
to help me for $500, I went home, dis-
traught, and did some research on my 
own.  I found out about a data recovery 
utility, Search and Recover (about $30) 
and bought it at a computer store.  After 
hours of work, I was able to get back 
most of what I lost but will forever mourn 
the loss of the 2005 Wisconsin State Fair.  
But I did learn a valuable lesson:  keep 
a good backup.

As I said above, I burn a DVD of my im-
ages and also copy them to my terabyte 
drive.  That sounds like a good backup, 
but only if one copy is stored somewhere 
else.  If you make a backup of computer 
files and store it next to the computer, 
then what happens if there is a fire or a 
flood?  Both copies are ruined and your 
backup is no good.  You should either 
store the DVD in a safe-deposit box 
(where it is climate-controlled and safe) 
or you can ask a friend to keep it at their 
house (hopefully, someplace safe) , or 

you can (maybe) take it to work and put 
it in your (locked) drawer there.

To make a backup, you need ap-
propriate hardware and software.  The 
hardware would be either the DVD 
burning capabilities on your PC, or, if 
your PC can’t burn DVD’s, you need to 
purchase an external DVD burner.  (Al-
ternately, you could use a tape backup, 
which should come with its own pro-
prietary backup software).  Roxio and 
Sonic software are good DVD burning 
utilities that come with many PC’s, or 
you may have another DVD burning util-
ity that you can use to copy your files.   
You can also just use the copy feature 
in the My Computer area of your PC. 
(I apologize to Mac users, as I am not 
acquainted with backup methods on 
that system). 

Store your DVD’s in slim jewel boxes, 
and give a detailed description of the 
contents of the DVD – if you ever need 
it, you won’t want to waste a lot of time 
searching for things.  If you realize the 
importance of a good backup, you will 
sleep better the day that you have one 
safely tucked away.

Once you have your photos properly 
backed up and are ready to edit, open 
the image in Photoshop Elements and 
immediately save it to somewhere safe 
on your PC’s hard drive.  This will pre-
vent you from overwriting your original 
and losing it.  To do this, click on FILE – 
DUPLICATE – OK, thereby automatically 
creating a copy of the original image.  
In order to save this duplicate image, 
if you click on SAVE, it will place the 
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As discussed on the page about copyright registration, 
registering works with the U.S. Copyright Office provides sig-
nificant advantages when seeking redress against infringers. 
Registration of groups of photographs is neither expensive 
nor difficult and can be done quickly and with little effort if 
steps are taken to incorporate copyright issues into the nor-
mal work flow of processing images. Photoshop’s actions 
function can be used to expedite the process of creating 
the deposit of images that is required when you submit your 
registration application and can also enhance the level of 
copyright protection by embedding a copyright notice into 
the metadata of your image files. 

The first action described below saves the file in the cur-
rent directory, prepares a low-resolution copy, stores the 
low-resolution copy in a separate designated folder, and then 
closes the image file. The low-resolution images can then be 
copied from the folder onto a CD or DVD for inclusion with 
the application. If you want, you can modify this action to 
create actions that copy the low-resolution files to different 
destination folders for published and unpublished images. 

The second action embeds a copyright notice and related 
information for unpublished images into the IPTC space of a 
digital image file. IPTC is an internationally recognized pro-
tocol that enables text information to be embedded in the 
image for future reference. Using this action will also cause 
Photoshop to display a copyright symbol on the title bar 
of images that are opened in Photoshop. If you want, you 

copy in the same directory and folder that it came from.  This 
means that if your image is coming from an external drive, 
it will be saved right back into the folder on that external 
drive where the original is stored.  A better choice would be 
to use SAVE AS and to direct the image to a place on your 
hard drive where you store working images.  I have a whole 
directory of Camera Club images, with subdirectories by 
competition type and date.  I also have a “possibilities” file 
for my working images:

Camera Club
	 Camera Club Color
		  Color 0405  (Contains individual images)
		  Color 0506	 “	     “ 	       “		

		  Color 0607        “	     “             “
		  Color 0708	 “	     “	       “
	 Camera Club Monochrome
		  Mono 0405   (Contains individual images)
		  Mono 0506       “	     “	       “
		  Mono 0607	 “               “	       “ 
		  Mono 0708  	 “               “	       “
	 Camera Club Nature
		  Nature 0506   (Contains individual images)
		  Nature 0607      “                “              “
		  Nature 0708	 “	     “	        “
	 Possibilities 2008-09   (Contains individual images)

When I am finished working on an image in the Possibilities 
folder and enter it in competition, I make sure to give the im-

age the name that I used for competition so that I can easily 
find it and be sure of what it is.  My file naming convention 
is my initials plus the image name (e.g. MRLandscapeArch, 
or for mono, MRLandscapeArchBW).  I then file the image in 
the appropriate Camera Club folder.  Images stay in the Pos-
sibilities folder until they are used (and refiled elsewhere) or 
deleted, and the images are frequently reviewed so that the 
file doesn’t become too large.  If there are too many photos in 
the Possibilities folder, it can be better organized by creating 
subfolders within it and dividing the works in progress any 
way you see fit.  Sorting them by image type (color, mono, 
nature, photojournalism) or place taken (Utah, Wisconsin, 
Chicago, etc.) will keep them in good order.

It is easy to create new folders in which to store images.  
When saving an image using SAVE AS, use the drop down 
box at the top to select the drive and directory that you will 
be saving to.  Once you have the proper directory listed 
(e.g. My Pictures), create a new folder by right clicking the 
mouse, then clicking on NEW and then FOLDER.  A new 
folder appears, all ready to be named.  Give the folder a 
name and click on it to open it, then save your image to that 
folder, changing the format (shown under the file name) to a 
Photoshop file (.psd). 

There are many different ways to organize your photos, 
and these tips may have inspired you to get to work on an 
organizing scheme and backup procedure of your own.  Any 
organization is better than none at all, so resolve to keep 
those images in line in 2009! 

Continued from page 2...

Using Photoshop to Enhance Copyright Protection
by Bert Krages

can modify this action so that it can be used for published 
images. 

The Copyright Dump Action 
To create the Copyright Dump action:

Create a directory folder called “Copyright Dump” or 1.	
similar name. This is the directory in which you will store the 
low-resolution images produced by the action. When you 
are ready to submit the application to register the copyrights 
to the images, you can copy the images in the folder onto 
a CD or DVD.

Open an image for which you will want to register the 2.	
copyright. 

Go to the View menu and click to make the “Actions” 3.	
palette appear on the monitor.

Click on the “New Action” symbol which is the square-4.	
within-a square icon at the bottom of the palette.

Enter “Copyright Dump” in the space for “Name” and 5.	
click on “Record.”

Click onto the “File” menu and then click onto “Save.” 6.	
This will save the image in its current file folder.

Click on the “Image” menu and click on “Image 7.	
Size.” 

Click on “Auto Resolution” and enter “75 lines per inch” 8.	
in the space for “Screen.

Click OK and then click OK to exit the Image Size 9.	
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Continued from page 3...
palette. The image size should now be 
smaller.

Click onto the “File” menu and 10.	
then click onto “Save As.” Make the file 
type either JPEG, TIFF, or GIF. Change 
the folder to “Copyright Dump” and 
click “Save.”

Click on the square at the bottom 11.	
of the action palette to stop recording 
the action.

To use the Action 
Each time you are done processing 

an image in Photoshop, play the action 
and Photoshop will automatically save 
the file into its current directory and then 
create and store a low- resolution copy 
into the Copyright Dump folder. When 
you are ready to submit the registration 
application to the U.S. Copyright Office, 
you can copy the entire Copyright Dump 
folder onto a CD or DVD to prepare 
the required deposit. Afterwards, you 
should copy the files to another CD or 
DVD for your records and delete all the 
images from the folder. Alternatively, 
if you want to keep the record of the 
registered images on your hard drive, 
you can rename the Copyright Dump 
directory to correspond to the title used 
on the registration application (e.g., Im-
ages, October to December 2006) and 
create a new folder called “Copyright 
Dump.” 

The Copyright Notice Action
To create the action: 

Open an image for which you 1.	
want to insert the copyright notice.

Go to the View menu and click on 2.	

“Actions” to make the Actions palette 
appear on the monitor.

Click on the “New Action” symbol 3.	
which is the square-within-a-square 
shaped icon at the bottom of the pal-
ette.

Enter “Copyright Notice” in the 4.	
space for “Name” and click on “Re-
cord.”

Click on the “File” menu and then 5.	
click on “File Info.”

Enter your name into the space 6.	
for “Author,” click on the space for 
“Copyright Status” and indicate “Copy-
righted Work.”

In the space for “Caption,” en-7.	
ter “unpublished work Alt-0169” from 
the numbers keypad if using a PC or 
“unpublished work Option-g” if using 
a Mac. Append this phrase with your 
name and the year of creation so that 
the entire phrase reads something like 
“unpublished work © Your Name 2005.” 
Copy and paste this information into the 

space of “Copyright Notice” as well. You 
want to use the caption space because 
this is where some other programs 
read the basic file information. It is a 
good idea to include your address and 
contact information into the caption 
space.

Click on “OK” and then click on 8.	
the square at the bottom of the Action 
palette to stop recording the action.

Note: You can create a separate ac-
tion to be used for published images. To 
do this, omit the phrase “unpublished 
work” in step 7 and insert the year of 
first publication. 

To use the action: 
Each time you are finished with pro-

cessing an image in Photoshop, play the 
action and Photoshop will automatically 
insert the textual information into the 
IPTC space.

 The author is a photographer and at-
torney in Portland, Oregon.  The article 
is reprinted with his permission.

CALL FOR ENTRIES! CACCA is now  
holding a postcard competition. One of 
the main complaints with entering print 
competitions is the cost involved. Now, 
you no longer have that as an excuse! A 
postcard –  a simple 4x6 image, either 
vertical or horizontal. What could be 
simpler? This competition is open to 
any individual who is a member of a 
CACCA club. 

Your challenge is to make your won-
derful images into a postcard. Double 

by Mark Southard
weight paper is a good idea, or pasting 
your photo to a light paperboard, or 
even using the postcard backings avail-
able at your local photo store. 

The subject matter is totally your 
call, nature, abstract, pictorial, hand-
colored, etc. Go for humor, brilliant 
color, historic, whatever… but have fun! 
The judges have no preconceived ideas. 
This is a truly open competition. This 
will be a part of CACCA’s April competi-
tion. In particular, encourage your new 
members who might be intimidated 
by the impressive large prints they see 
each month. 

AWARDS. They will be based on 
the number of entries just as in other 
CACCA competitions. 

1. Number of entries – a maximum of 
four (4) per person. 

2. Size – 4x6. Color or black and 
white prints. 

3. All entries must supply a title, 
camera club, name, address and phone 
number along with your signature to 
signify that the image is your own. 

4. If you would like a list of winners, 
include your e-mail address. 

5. Although this is an individual com-
petition , your own club may want to have  
a separate contest, as is being done by 
Des Plaines, Lombard and others. 
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WHAT’S CLICKIN’
BY JANET SCHLEETER

First order of business is to let the newsletter editors and/or 
club secretaries know that I have a new email address. Please 
send copies of club newsletters to jsphoto222@sbcglobal.net 
instead of the “janet49” address used previously. 

Now that I have hi-speed it’s possible for me to take a 
better look at the club websites. If you haven’t done this 
yourself, go to www.chicameraclubs.org, click on “clubs” 
then “club websites”. Wow! Bob Brandes has made this so 
easy. I did notice a listing for Salt “Creak”. Is this a reflection 
on the age of the members???

We all know the economy is in the dumps, but look on the 
bright side—in 2002 Adorama was selling a San Disk 16 MB 
memory card for $21.95. The largest listed in their ad was 
a 1 GB which was $659.95! Unfortunately, ink cartridges 
haven’t gone down the equivalent. I was listening to a tech 
radio program recently, and I don’t know if it is correct, but 
it was mentioned that some inks cost around $8,000 per 
gallon. (We thought gas was expensive!) I don’t know how 
much ink is in a single cartridge, but considering that there 
are 128 ounces in a gallon, you 
know there is no such thing as 
cheap ink. 

Congratulations to Pixel 
Image Camera Club. They cel-
ebrated their 10th anniversary 
and were the first of several digital clubs to form. Their 
members continue to teach each other everything from the 
simple to the complex. Way to go, Pixel!

Foresters’ newsletter included timely tips on photograph-
ing snow (overexpose 1-2 stops) and capturing Thanksgiving 
with your camera. The key is to make sure the desired focal 
point of you photo (is it Grandma or the turkey) is the most 
important thing in the frame. Eliminate distractions. Capture 
the spirit of the holiday and the sense of family. One sug-
gestion is to use the famous Norman Rockwell painting as a 
guideline—don’t just have everyone sitting at the table look 
at the photographer. Capture them doing something such as 
making a toast or watching the turkey being carved.

Upcoming programs:
January 19 - Riverwoods-“It’s a Wet World” by Will Clay
January 19 - Mayslake-“Lightroom 2” by Fred Drury
January 27 - Downers Grove – 5-minute digital programs 

by members
February 16 - Riverwoods—“Travelogue-The Amazon” 

by Dave Madden
February 16 - Mayslake –“Converting Digital Images to 

Black & White” by Don Carter
February 17 - Downers Grove – “Portrait Lighting” by 

Bruce Van Pelt
March 16 - Riverwoods—“Weather Photography” by 

Mike Caplan
Just an FYI, the Canon photographers beat out the Nikon 

photographers in the special contest at Washington Park. 
Quote of the month: “Just because you own a Nikon does 
not mean you are a photographer, it means you are a Nikon 
owner.” This was overheard at SWMCCC and reprinted in 
the newsletter at the request of the Canon team. Canon-88, 
Nikon-85.5. The club members had a great time with this 
and considered everyone winners.

I find out all kinds of interesting tidbits from the newslet-

ters. Garden points out that you may have printer feeding 
problems in the winter because of the change of humidity 
in the house. Use a small humidifier, and if you have trouble 
with static, you might rub a fabric softener sheet on the paper 
before feeding. This info came from the Red River website-
www.redriverpaper.com. You can check out their blog and 
sign up for their newsletter at blog.redriverpaper.com. 

Nature Camera Club of Chicago’s new “photo findings” 
feature list hints, websites, gadgets, etc. found of interest to 
its members. Here’s something from a recent newsletter:

The complete archive of photographs from Life Magazine is 
now available online, free, for viewing, downloading, and even 
manipulation, and the resolution of the pictures is high enough to 
be printed on your printer in sizes up to 8 x 10. Go to the Images 
section of Google and enter Life Magazine. There are currently 
2 million images in the library and up to 10 million are expected 
eventually. Most of them have never been published.

Nature always includes an excellent CACCA update and 
links to interesting websites. 

I have made frequent refer-
ences to Arlington Camera 
Club’s newsletter. I can’t in-
clude all the interesting stuff 
in What’s Clickin’, but you 
can see the whole newslet-

ter at their website www.arlingtoncameraclub.org. It’s one 
newsletter that despite the cost of ink, I always like to print 
out to make sure I don’t miss anything. The December issue 
includes a photo-oriented article on the Canadian Rockies by 
Diana Jacobson. Diana toured via a workshop given by Joe 
and Bonnie Lange. Her experience even included a helicop-
ter ride to the remote Mount Assiniboine Lodge where you 
could just sit on the porch and take pictures right there. 

Kankakee judged their scavenger hunt in December. This 
year the club scheduled an outing to Dollinger Farms (Chan-
nahon/Minooka/Morris area) in October to photograph Civil 
War and autumn subjects. Subjects included: horse, settler, 
soldier, cooking area, cannon, battle, ammo, musket, autumn 
theme, wagon, pumpkins, and musical instrument.  There 
were some competition quality images that came out of this 
fun event. If you have never been to this place, it isn’t an 
historic farm, but they host 2 special events, a steam show 
in July and a Civil War encampment and battle re-enactment 
in October. If you are interested in that type of photography 
check their website www.dollingerfarms.com for the latest 
information on these events. 

Here’s to a healthy 2009. A number of our members have 
had serious health issues, and we hope everyone gets better 
this year. Those who especially need our thoughts, cards, 
and prayers include Ruby Riota, Mary Root, Pat Wadecki, 
Sam Krizan and Don Alton. We’d like to see them all feeling 
better in the new year.

A couple of final notes to delegates. Some of you come 
to the CACCA meetings and immediately start looking for 
stickers and forms for the current month’s entries. You can 
download these items from the CACCA website. Remem-
ber, it is your responsibility to make sure stickers are on the 
back of all Interclub print entries and to be sure both parts 
of the 2-part entry form are completely filled in. Thanks for 
all you do!
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2008-2009 Competition Dates   

		  10/11	 11/8	 12/13	 1/10	 2/14	 3/14	 4/11	 5/9

Interclub Slides & Prints		  X	 X	 X	 X	 X	 X  	      X	 X

Alteration of Reality Prints			   X		  X		  X			 

Photojournalism Slides & Prints		  X		  X		  X

Nature Slides & Prints		  X		  X 	  	 X

Portrait Prints & Slides			   X		  X		  X

CACCA Spring Salon Material Due						      X

Special Category Slides		  X	 X	 X	 X	 X	 X  	      X	 X

The deadline for entries in the Interclub Digitally Projected Images Slide division will be one week before the monthly 
CACCA meeting.

The Best of Year in the Individual Nature Slide and Print divisions and judging for the Grace DeWolf Award (for diver-
sity in nature photography) in both slides and prints will be March 14. Up to six images that have been in competition 
during the three competitions may be submitted.  Any point count can be entered for three of the six images.  The 
other three must be awards or have earned at least 24 points.

Special Category Subjects: Oct. Places of worship or a part thereof; Nov. – Old weathered things; Dec. – People, 
two or more; Jan. – Wild animals; Feb. – The letter “P”, must appear in the title, e.g., purple, pepper, pigs, etc.; Mar. 
– geology, e.g., mountains, rocks, rock formations; Apr. –Two colors.

Spring Salon: Saturday, March 21, 2009   

Awards Banquet: Sunday, June 13, 2009

Wildlife Photography in the Comfort of Your Home

It’s cold outside. The 
wind and snow are blow-
ing. It is a great time for 
winter wildlife pictures. 
Even better if you are warm 
and dry in your home. You 
can take a natural picture 
from your window with a 
little planning and prepa-
ration.

First you want the birds 
to be where you can pho-
tograph them – well lit and 
close. Remember most 
birds are tiny. Ten feet 
away can allow reason-
able coverage with a hand 
held telephoto. Currently 
I am using a Nikon D200 
with a 70-200mm 2.8 VR 
and a 1.4 extender. This 
gives me a 420mm 35mm 
equivalent in a package that can be easily hand held. It can 
also fire bracketed shots at 5 fps. Because of the white on 
songbirds, and the dark areas on others, I bracket three 
shots at metered + .7 EV. Most small birds need a setting 
of f8 or f11, and as much shutter speed as you can get. 
Normally in the winter a setting of ISO 640 will get a shutter 
speed of 1/60 to 1/125.

by Bob Noble

How do you get the birds 
well lit and close? I use a 
setup on my back patio of 
two or three 16 inch flower 
pots filled with stones. 
Into these are placed tree 
tops or branches. They 
are then located so that 
the branches photograph 
well from my living room 
or office.

Three feeders are lo-
cated off the patio behind 
the potted branches – a 
suet feeder, thistle seed 
sock, and a feeder filled 
with equal amounts of 
black sunflower and mil-
let. The feeders attract 
cardinals, nuthatches, 
finches, sparrows, wood-
peckers, and other birds. 

I also get squirrels, and chipmunks.
This is wildlife photography, so there is a lot of waiting. 

Ideally you will have camera in hand while looking at your 
dead tree in a flower pot, and some great bird will land on 
a branch, pose in a number of positions (all with eye high-
light) and you will have a 100 bracketed photos to choose 
from. Good luck.

This Red-breasted Nuthatch was photographed from the 
author’s living room window.


